
 
 

BAB III 

METODE PENELITIAN 

 

 

3.1 Metode Pengumpulan Data 

 

 Metode yang digunakan untuk melakukan pengumpulan data yaitu: 

 3.1.1 Studi Pustaka 

 segala usaha yang dilakukan oleh peneliti untuk menghimpun informasi  

  yang relevan dengan topik atau masalah yang akan atau sedang diteliti.  

  Informasi itu dapat diperoleh dari buku-buku ilmiah, laporan penelitian,  

  karangan - karangan ilmiah, tesis dan disertasi, peraturan-peraturan,  

  ketetapan-ketetapan, buku tahunan, ensiklopedia, dan sumber-sumber  

  tertulis baik tercetak maupun elektronik lain. 

 

 3.1.2 Wawancara 

  Yaitu pengumpulan data dengan cara melakukan pembicaraan dan  

  memberikan pertanyaan langsung kepada petugas bagian penelitian tanaman  

  di BPTP Lampung dan petugas bagian holtikultura Dinas Pertanian Provinsi  

  Lampung. 
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- Pertanyaan / Wawancara :  

1. Penyebaran ubi kayu di daerah provinsi lampung terbanyak di daerah 

mana saja? 

2. Tanah yang seperti apa yg baik untuk pertumbuhan ubi kayu? 

3. Ubi kayu jenis apa yang massa panen nya lebih cepat? 

4. Jenis apa saja ubi kayu yang terdapat dan banyak di Tanami untuk 

daerah lampung? 

5. Sistem tanam yang baik untuk ubi kayu seperti apa? 

 

- Jawaban : 

1. Pada umum nya ubi kayu tersebar di daerah lampung, namun jenis ubi 

kayu yang untuk produksi contoh UJ-3 (Thailand), UJ-5 (cassesart), 

dan Malang. 

2.  Secara umum ubi kayu dapat tumbuh di tekstur berpasir hingga liat, 

lempung berpasir, dan PH Tanah 4,5-8, optimal 5,8. 

3. Ubi kayu jenis UJ-3 (Thailand) massa panen nya lebih cepat 8-10 bulan 

massa umur. 

4. Untuk daerah lampung ubi kayu yang banyak di Tanami masyarakat itu 

jenis, UJ-3 (Thailand), UJ-5 (Cassesart), Malang-6, dan Barokah 

(Lokal). 

5. Sistem tanam nya, untuk UJ-3 : Rapat(70x80 cm), UJ-5 : Double Row, 

Malang-6 : Rapat(70x80 cm), Barokah(Lokal) : Double Row.  

 

 3.1.3 Observasi 

  Mengumpulkan data dengan melakukan pengamatan langsung di Dinas  

  Pertanian Provinsi Lampung. (Data Terlampir) 

 

 

3.2 Metode Pengembangan Perangkat Lunak 

 

Penelitian ini menggunakan rekayasa perangkat lunak dengan model System 

Development Life Cycle (SDLC) model waterfall. 
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 3.2.1 Perencanaan (Planning) 

 

Pada saat ini Dinas Pertanian Provinsi Lampung dalam menyampaikan 

informasi  mengenai kesesuaian lahan tanaman ubi kayu masih menggunakan 

tabel dan belum memiliki data yang lengkap. Hal ini disebakan karena belum 

terdapat sistem informasi geografis berbasis web yang dapat membantu petani 

ubi kayu dan masyarakat umum untuk mendapatkan informasi mengenai 

kesesuaiann lahan ubi kayu di Provinsi Lampung, maka dari itu akan 

dibangun sebuah sistem informasi berbasis web tentang kesesuaian lahan 

tanaman ubi kayu pada Provinsi Lampung.  

 

 

 3.2.2 Analisis (Analysis) 
 

Analisis merupakan tahapan menganalisa hal – hal yang diperlukan dalam  

Membangun Sistem Informasi Geografis Tentang Kesesuaian Lahan 

Tanaman ubi kayu Pada Provinsi Lampung. Analisis ini menjelaskan tentang 

hasil penelitian sistem yang sedang berjalan. 

 

 -   Proses Digitasi Peta 

Registrasi peta adalah awal dalam membuat peta digital, sebelum peta hasil scan  

dapat di digitasi terlebih dahulu kita melakukan registrasi peta biasa disebut koreksi 

geometrik. Registrasi peta adalah untuk mendaftarkan koordinat peta hasil scan  

atau image hasil citra satelit supaya sesuai dengan koordinat di muka bumi. 

Langkah-langkah: 

- Pada Extensions, ceklist ekstensi JPEG (JFIF) Image Support dan Register 

and Transform Tool. Untuk membuat ekstensi berjalan pada saat ARCView 

Start-up ceklist make default kemudian klik OK. 

- Double klik View, Klik menu View->Add Theme. Pada Data Source 

Types pilih Image Data Source. Pada Drives pilih d:\ klikpada peta.jpg. 

http://blog.aditya-nursyahbani.com/2012/08/registrasi-peta-menggunakan-arcview-gis.html


31 
 

 
 

- Ceklist pada Peta.jpg pada jendela View untuk melihat 

petanya.Klik menu View->Register and Transform untuk memulai 

registrasi peta. 

- Pada menu Register and Transform, buat Source Point (minimal 4 titik ikat 

pada setiap pojok atau ujung peta_contoh) dengan cara klik toolbar 's' lalu 

arahkan pada titik peta_contoh yang akan di registrasi. 

Input Destination sesuai dengan titik koordinat pada peta_contoh. 

- Jika 4 titik ikat sudah diregistrasi, lihat pada RMS Error, semakin kecil nilai 

RMS Error maka hasil registrasi semakin baik. Ceklist Store Control 

Points dan klik Write World File, simpan file peta.jgw pada direktori yang 

sama D:\klik OK. Close atau Exit ARCView dan buka kembali, tambahkan 

theme (View->Add Theme) filepeta.jpg yang telah diregistrasi. Jika 

registrasi berhasil, maka koordinat yang telah di registrasikan sesuai atau 

sama dengan koordinat muka bumi dan peta siap untuk di digitasi.  

- Digitasi 

Ada 3 konsep untuk digitasi peta pada ArcView GIS 3.3 

yaitu : 

1. Polyline: digunakan untuk menentukan jalan - jalan di sebuah peta 

2. Polygon: berfungsi atau biasa digunakan untuk menentukan batas wilayah 

suatu daerah pada peta. 

3. Point: Point pada ArcView GIS 3.3 dipakai untuk menentukan suatu 

tempat, misalnya, Rumah Sakit, Restoran, Sekolah, gedung - gedung, 

Bioskop, Mall dll 

Berikut langkah - langkah lengkap cara digitasi dengan menggunakan Konsep 

Polyline, Polygon dan Point : 

- Extension 
Sebelum melakukan langkah-langkah Digitasi Point kita menginputkan 

gambar peta terlebih dahulu : 

  Menu  File  

  Extensions (maka  akan  muncul  window  dialog Extensions)  

 

kemudian  cari  ekstensi   JPEG  (JFIF)  Image  Support dan  Geoteknika  

Indonesia 
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- Menambah Theme Image : 
  Menu View  

Add theme   

  soure  type  adalah  Image  Data Source. Kemudian tekan OK. 

 

- Digitasi Point 
     Tambahkan Theme Baru  

          Menu View  

            New Theme  

           Pada New Theme window pilih Featuer Type adalah Point, Kemudian 

tekan OK. 

         Kemudian atur tempat file dan nama file. 

Cek  Hasil dari Digitasi Point. 

 

- Digitasi Line 
Langkah-langkah dalam pengerjaan Digitasi Line hamper sama seperti 

Digitasi Line untuk tahap Extension , hanya berbeda dalam penggunaan 

tools, yang mana menggunakan tools Line. 

Kemudian Pilih Tool Draw untuk Line Draw, di bawah ini adalah hasil 

dari Digitasi Line:  

 

- Tabel 

Tabel merupakan salah satu bagian ArcView yang keberadaanya tidak dapat 

dipisahkan dari View. Fungsi tabel pada ArcView sebagai sarana 

penyimpanan data-data atribut dari data spasial. Langkah- langkah : 

Buka File -> New Project 

 

Lalu click table. Untuk menambahkan table atau membuat table baru click 

new, dan tulis nama table yang diinginkan. 

      Buat field database kecamatan dan isikan segala info dalam database,  

 

- Chart 

Chart atau grafik pada ArcView merupakan fasilitas yang digunakan untuk 

menyajikan data tabular dari atribut data-data spasial. Sebuah grafik dapat 

menampilkan semua record pada tabel atau sebagian record yang terpilih. 

Grafik akan mengikuti secara otomatis jika record yang terpilih berubah. 

ArcView dapat membuat bermacam-macam grafik yang menggambarkan data 

sesuai dengan aplikasi yang dikehendaki. 
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 a. Analisis Sistem Yang Berjalan 

  Saat ini petani ubi kayu dan masyarakat umum ketika ingin mencari  

   sebuah informasi mengenai kesesuaian lahan tanaman ubi kayu akan  

   memperoleh informasi langsung dari Dinas Pertanian Provinsi Lampung  

   dan BPTP Lampung dengan mendatangi langsung kantor Dinas Pertanian  

   Provinsi Lampung dan BPTP Lampung. 

 

 b. Kelemahan Sistem Yang Berjalan 

  Kelemahan dari sistem yang berjalan saat ini adalah tidak adanya  

   pemetaan digital tentang informasi kesesuaian lahan untuk tanaman  

   ubi kayu sehingga sulitnya petani ubi kayu dan masyarakat untuk  

   mengetahui lahan yang sesuai untuk di tanami tanaman ubi kayu di  

   Provinsi Lampung. 

 

 c. Metode Forward Chaining Pada Sistem Informasi Geografis 

  1. Rule Pada Program 

   Rule 1 

   IF Varietas 

   And Tinggi Tempat 0-750 Mdpl 

   And Curah Hujan 750-1.000 Mm/th 

   And Suhu 25-27˚C 

   And PH Tanah 4,5-6 

   Then UJ-3 (Thailand) 

 

   Rule 2 

   IF Varietas 

   And Tinggi Tempat 0-750 Mdpl 

   And Curah Hujan 750-1.000 Mm/th 

   And Suhu 25-27˚C 

   And PH Tanah 9 

   Then UJ-5 (Cassesart) 
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   Rule 3 

   IF Varietas 

   And Tinggi Tempat 0-750 Mdpl 

   And Curah Hujan 750-1.000 Mm/th 

   And Suhu 19-33˚C 

   And PH Tanah 3,9 

   Then Malang-6 

 

   Rule 4 

   IF Varietas 

   And Tinggi Tempat 0-750 Mdpl 

   And Curah Hujan 1.000-1.500 Mm/th 

   And Suhu 19-33˚C 

   And PH Tanah 8 

   Then Barokah (Lokal) 

 

   Rule 5 

   IF Varietas 

   And Tinggi Tempat 1.000-2.000 Mdpl 

   And Curah Hujan 950-1.000 Mm/th 

   And Suhu 19-33˚C 

   And PH Tanah 7 

   Then Jenis Lainnya 

         

 d. Tahapan Sistem Informasi Geografis 

  Tahapan dalam SIG terdiri dari 5 tahapan yang meliputi input, proses dan  

   output yang dijelaskan berikut ini: 

   1. Pengumpulan Data 

   Pengumpulan data dilakukan dengan melakukan penelitian di Dinas  

    Pertanian Provinsi Lampung dan BPTP Lampung. Metode  

    pengumpulan data yang dilakukan adalah dengan melakukan studi  
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    pustaka, observasi dan juga wawancara langsung dengan bagian  

    hortikultura dan bagian peneliti tanaman. 

  2. Input Data Spasial 

   Penginputan Data Spasial yang digunakan dalam peta digital yaitu  

    peta yang  berupa gambaran permukaan bumi yang diolah dengan  

    bantuan media komputer.  Peta yang digunakan adalah peta Provinsi  

    Lampung yang akan diolah berdasarakan penyebaran varietas sesuai  

    dengan ketinggian tempat untuk lokasi lahan tanaman ubi kayu. 

 

- Data spasial polygon 

 

 

 

 

 

    

 

 

   POLYGON((103.56782140032655 -4.923598333332927,103 

POLYGON((105.19614685953377 -5.795974402065268,105 

POLYGON((105.3499012948095 -5.517014258688005,105 

POLYGON((104.95642051953111 -5.572195703644251,104 

POLYGON((104.34036123078356 -4.866934815022349,104 

POLYGON((105.2092363801322 -5.364448905350014,105 

POLYGON((104.5760736096133 -5.059663507538757,104 

POLYGON((105.82531658359589 -5.57414165469612,105 

POLYGON((105.89025704061424 -4.685791955254535,105 

POLYGON((105.31706277973761 -5.051744983973439,105 

POLYGON((105.81556382265066 -4.65128001929661,105 

POLYGON((104.92911818519713 -4.185786127653091,104 

MULTIPOLYGON(((105.74254030729794 -4.1335132583187 

POLYGON((105.0161086159605 -4.167639374592485,105 
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   Gambar 3.1 Polygon dan Titik 

  - Data Spasial Titik 

POINT(105.181369 -5.153165) 

POINT(104.93761 -4.334216) 

POINT(105.816593 -4.527923) 

POINT(105.025717 -4.700744) 

POINT(104.032193 -4.935278) 

POINT(105.203106 -5.327152) 

POINT(105.184965 -4.112912) 

POINT(105.302801 -5.153987) 

POINT(105.114479 -4.521186) 

 

  3. Input Data Atribut 

Data Atribut yang akan diinputkan adalah data mengenai informasi 

dari setiap kabupaten dan kota. Data tersebut didapatkan dari buku 

online Badan Pusat Statistik di masing-masing daerah di Provinsi 

Lampung, dan data hasil observasi di Dinas Pertanian Provinsi 

Lampung dan BPTP Lampung. Data tersebut kemudian akan diolah 

menjadi Sistem Informasi Geografis kesesuaian lahan tanaman ubi 

kayu Pada Provinsi Lampung. 
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  - Data Atribut Kab/Kota 

   1. Provinsi   :Lampung 

Kabupaten/Kota  :Lampung Barat 

Ibu Kota   :Liwa 

Ketinggian   :0 - 2.000 m dpl 

Curah Hujan   :2.500 - 3.000 mm/th 

Suhu    :19 - 33�C 

pH Tanah   :3,9 

Varietas Unggul  :UJ-5(Cassesart), Malang-6, Barokah     

  (Lokal) 

Panen 2012   :13.680 ton 

Panen 2013   : 5.694 ton 

 

2.  Provinsi    : Lampung 

 Kabupaten/Kota  : Tanggamus  

 Ibu Kota    : Kota Agung  

 Ketinggian    : 0 - 2.115 m dpl  

 Curah Hujan   : 2.000 mm/th 

 Suhu    :18 - 28�C  

 pH Tanah   : 9  

 Varietas Unggul   :UJ-5 (Cassesart), Malang-6, Barokah  

                   (Lokal)  

 Panen 2012   :12.270 ton 

 Panen 2013   :13.849 ton 

 

3.  Provinsi     : Lampung  

Kabupaten/Kota   : Pringsewu  

Ibu Kota    : Pringsewu  

Ketinggian    :1.000 - 2.000 m dpl  

Curah Hujan   :2.264 - 2.868 mm/th  

Suhu     :26 - 29�C  

pH Tanah    :6,6  

Varietas Unggul    :UJ-5 (Cassesart), Malang-6, Barokah  

               (Lokal)  

Panen 2012    :12.850 ton  

Panen 2013   :13.606 ton  

 

4.  Provinsi     : Lampung  

Kabupaten/Kota   : Pesawaran  

Ibu Kota    : Gedong Tataan  
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Ketinggian    :1.000 - 2.000 m dpl  

Curah Hujan   :2.264 - 2.868 mm/th  

Suhu     :26 - 29�C  

pH Tanah     :7  

Varietas Unggul    :UJ-5 (Cassesart), Malang-6, Barokah  

                                                          (Lokal)  

Panen 2012    :71.001 ton  

Panen 2013   :86.429 ton 

 

5.  Provinsi     : Lampung  

Kabupaten/Kota    : Bandar Lampung  

Ibu Kota     : Bandar Lampung  

Ketinggian    :0 - 700 m dpl  

Curah Hujan   :2.257 - 2.454 mm/th 

Suhu     :23 - 37�C  

pH Tanah     :3,6  

Varietas Unggul   :UJ-5 (Cassesart), Malang-6, Barokah  

                                            (Lokal)  

Panen 2012    :3.390 ton  

Panen 2013   :4.234 ton  

 

6.  Provinsi     : Lampung 

 Kabupaten/Kota   : Lampung Selatan  

 Ibu Kota    : Kalianda  

 Ketinggian    : 0,5 - 1.261 m dpl  

 Curah Hujan   : 1.000 - 2.000 mm/th  

 Suhu     : 21,20 - 34,10�C  

 pH Tanah   : 4  

 Varietas Unggul    : UJ-5 (Cassesart), Malang-6, Barokah  

                                          (Lokal) 

 Panen 2012    : 214.730 ton  

 Panen 2013   : 210.175 ton 

 

7.   Provinsi     : Lampung  

Kabupaten/Kota    : Lampung Timur 

Ibu Kota     : Sukadana  

Ketinggian    : 0,5 - 200 m dpl  

Curah Hujan    : 800 - 3.000 mm/th  

Suhu     : 23 - 34�C  

pH Tanah    : 3 – 7 

Varietas Unggul    : UJ-3 (Thailand), UJ-5 (Cassesart),  

                   Malang-6, Barokah (Lokal)  

Panen 2012   : 1.236.925 ton  
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Panen 2013   : 1.342.254 ton 

 

8.  Provinsi     : Lampung  

Kabupaten/Kota   :Lampung Tengah  

Ibu Kota    : Gunung Sugih 

 Ketinggian    : 0,5 - 1.600 m dpl  

Curah Hujan   : 761,2 mm/th Suhu : 24 - 28�C  

pH Tanah    : 2 - 6   

Varietas Unggul    : UJ-3 (Thailand), UJ-5 (Cassesart),  

                                            Malang-6, Barokah (Lokal)  

Panen 2012    : 3.371.618 ton  

Panen 2013   : 2.968.247 ton 

 

 

9.  Provinsi     : Lampung  

Kabupaten/Kota   :Lampung Utara  

Ibu Kota    : Kota Bumi  

Ketinggian   :450 - 1.500 m dpl  

Curah Hujan    :600 - 2.005,37 mm/th  

Suhu     :21,3 - 33,7�C  

pH Tanah    :4 - 6  

Varietas Unggul    :UJ-3 (Thailand), UJ-5 (Cassesart), Malang- 

                                          6, Barokah (Lokal) 

 Panen 2012    :1.357.275 ton  

 Panen 2013   :1.556.199 ton 

 

 10.  Provinsi     : Lampung  

Kabupaten/Kota   : Way Kanan  

Ibu Kota    : Blambangan Umpu 

Ketinggian   : 450 - 1.500 m dpl  

Curah Hujan    : 800 - 2.500 mm/th  

Suhu    : 24 - 30�C  

pH Tanah    : 3 - 6  

Varietas Unggul   : UJ-3 (Thailand), UJ-5 (Cassesart),  

               Malang-6, Barokah (Lokal)  

Panen 2012    : 373.832 ton  

Panen 2013   : 448.207 ton 

 

11.  Provinsi     :Lampung  

Kabupaten/Kota   : Metro 

         Ibu Kota    :Metro  

Ketinggian   :25 - 75 m dpl  
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Curah Hujan   :864 - 2.868 mm/th  

Suhu    :22 - 26�C  

pH Tanah   :4 – 5 

Varietas Unggul   :UJ-3 (Thailand), UJ-5 (Cassesart), Malang- 

                           6, Barokah (Lokal) 

                     Panen 2012    :2.530 ton  

Panen 2013   :2.187 ton 

 

12.  Provinsi    : Lampung  

Kabupaten/Kota   : Tulang Bawang Barat  

Ibu Kota    : Panaragan Jaya  

Ketinggian   : 20 m dpl  

Curah Hujan   : 9.168,63 mm/th 

 Suhu    : 26,4 - 27,9�C  

pH Tanah   : 3 - 8  

Varietas Unggul   : UJ-3 (Thailand), UJ-5 (Cassesart),  

                                          Malang-6, Barokah (Lokal)  

Panen 2012   : 1.058.194 ton  

Panen 2013   : 982.294 ton 

 

13.  Provinsi     :Lampung  

Kabupaten/Kota   : Mesuji 

Ibu Kota    : Mesuji  

Ketinggian   :5 - 30 m dpl  

Curah Hujan    :900 - 2.500 mm/th  

Suhu    :26 - 28�C  

pH Tanah   :4 - 5  

Varietas Unggul   :UJ-3 (Thailand), UJ-5 (Cassesart), Malang- 

                                         6, Barokah (Lokal) 

Panen 2012   :126.661 ton  

Panen 2013   :120.778 ton 

 

     -   Data Atribut Kecamatan 

 1.  Kabupaten    : Lampung Selatan  

Alamat     : Jl. Alamsyah Ratu Prawiranegar  

Kecamatan   : Natar  

Hasil Panen    : 56,318 (Ton)  

Luas Panen    : 2,604 (Ha)    

Titik Koordinat    : Latitude   -5.327152   

                                          Long Titude 105.203106 
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2.  Kabupaten    : Pesawaran  

Alamat     : Jl. Lintas Timur Sumatera  

Kecamatan    : Tegineneng  

Hasil Panen    : 63,867 (Ton)  

Luas Panen    : 3,050 (Ha)    

Titik Koordinat    : Latitude  -5.153165 

   Long Titude 105.181369 

 

3.  Kabupaten    : Metro  

Alamat     : Jl. Budi Utomo  

Kecamatan    : Metro Selatan 

 Hasil Panen    : 1.837,55 (Ton)  

Luas Panen   : 83,00 (Ha)    

Titik Koordinat    : Latitude  -5.153987 

       Long Titude  105.302801 

4.  Kabupaten    : Lampung Barat  

Alamat    : Jl. Muara Dua - Liwa  

Kecamatan    : Sukau 

 Hasil Panen   : 3,011 (Ton)  

Luas Panen    : 54 (Ha)    

Titik Koordinat    : Latitude   -4.935278 

       Long Titude  104.032193 

 

5.  Kabupaten    : Lampung Utara  

Alamat     : Jl. Surakarta  

Kecamatan   : Abung Surakarta  

Hasil Panen   : 53,606 (Ton)  

Luas Panen    : 7,209 (Ha)    

Titik Koordinat   : Latitude  -4.700744 

   Long Titude  105.025717 

 

6.  Kabupaten    : Tulang Bawang Barat  

Alamat    : Jl. Raya Desa Panaragan  

Kecamatan   : Tulang Bawang Tengah  

Hasil Panen    : 187,824 (Ton)  

Luas Panen    : 6,708 (Ha)    

Titik Koordinat    : Latitude  -4.521186 

   Long Titude  105.114479 

 

7.  Kabupaten    : Way Kanan  

Alamat     : Jl. Purwa Agung  

Kecamatan   : Negara Batin  
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Hasil Panen   : 192,786,0 (Ton)  

Luas Panen    : 7,590 (Ha)    

Titik Koordinat    : Latitude   -4.334216 

   Long Titude  104.93761 

 

8.  Kabupaten    : tulang bawang  

Alamat    : jln Poros Dente Teladas  

Kecamatan   : Dente Teladas  

Hasil Panen   : 215,097 (Ton)  

Luas Panen   : 7,284 (Ha)    

Titik Koordinat    : Latitude  -4.527923 

   Long Titude  105.816593 

 

9.  Kabupaten    : Mesuji  

Alamat     : Jl. Gedung Boga/Raja  

Kecamatan   : Way Serdang  

Hasil Panen   : 53,775 (Ton)  

Luas Panen    : 2,151 (Ha)    

Titik Koordinat    : Latitude  -4.112912 

   Long Titude  105.184965 

 

  4. Analisa Database 

Dalam tahapan ini, database yang telah kita inputkan dapat kita 

tambahkan atau kita manipulasi. Tahapan ini adalah tahapan untuk 

pengecekan database yang telah diinputkan. 

  5. Menyajikan Hasil Analisa 

   Hasil analisa dapat disajikan dalam bentuk peta, tabel,  dan  

    laporan. 
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User

Informasi Ubi Kayu 

Kabupaten/Kota
Contact

Peta Kesesuain 

Lahan

Lihat

 

Lihat

 

Konsultasi 

Lahan

 

Lihat &

 Cek

Home

 

Lihat

 

Lihat

 

 3.2.3 Perancangan (Design) 

 

Perancangan sistem berfungsi mengimplementasikan kebutuhan sistem yang 

diusulkan berdasarkan hasil analisis sistem yang berjalan. Gambaran umum 

sistem informasi geografis kesesuaian lahan tanaman ubi kayu pada Provinsi 

Lampung yang diusulkan dijelaskan melalui tahapan rancangan sebagai 

berikut: 

 a. Input 

 b. Output 

 c. Struktur tabel database 

 d. Usecase Diagram 

3.3 Struktur Navigasi 

 

 3.3.1  Struktur Navigasi Pengunjung (user) 

 

Seorang pengunjung dapat melihat informasi mengenai halaman depan atau 

home, peta lahan tanaman ubi kayu di Provinsi Lampung, konsultasi 

kesesuaian lahan, sekilas tentang ubi kayu dan informasi Kabupaten/Kota 

atau data peta.  Pada gambar 3.1 adalah struktur navigasi dari user site, yang 

dapat dilihat bahwa dari halaman index atau halaman depan dapat langsung 

menuju halaman yang diinginkan, seperti halaman Peta, Konsultasi 

Kesesuaian Lahan, Informasi Kabupaten/Kota. 

    

 

 

 

  Gambar 3.2 Struktur Navigasi Pengunjung (user) 
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 3.3.2 Struktur Navigasi Administrator 

 

Dalam aplikasi ini, seorang administrator (orang yang bertanggung jawab atas 

pengelolaan suatu situs) dapat menambah, mengubah, menghapus, serta 

memproses data pesan oleh pengunjung melalui situs, dan juga melakukan 

update atau perkembangan dan pembaruan aplikasi ini. 

 

Pada gambar 3.2 adalah struktur navigasi dari administrator site, yang dapat 

dilihat bahwa dari halaman login menuju ke halaman home atau index, dan 

dari halaman home dapat langsung menuju kehalaman yang diinginkan, 

seperti data admin yang mencakup input, edit dan hapus data admin dan data 

peta yang mencakup edit data peta. 

 

 

 

 

 

 

 

 

Gambar 3.3 Struktur Navigasi Administrator 

*Keterangan : 

 I (Input) = Menambahkan data baru 

 E (Edit) = Mengubah data yang sudah ada 

 D (Delete) = Menghapus data yang sudah ada 

 V (View) = Melihat informasi dan peta 
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Aplikasi User

Informasi Ubi Kayu

Kabupaten/Kota

Konsultasi Lahan

Home

Contact
User

Peta Kesesuain

Lahan

3.4 Algoritma UML 

 

Dalam pembuatan website ini, penulis menggunakan bahasa pemrograman PHP 

dan MySQL yang berorientasi pada objek sehingga dalam menjelaskan alur 

program ini penulis menggunakan UML (Unified Modelling Language). UML 

merupakan bahasa standar untuk menjelaskan, memodelkan, dan 

mendokumentasikan sebuah rancangan software dan lainnya. Dalam pengertian 

OOP (Objeck Oriented Programming). Dengan mengunakan UML kita dapat 

membuat model untuk semua jenis aplikasi piranti lunak, dimana aplikasi tersebut 

dapat berjalan pada piranti keras, sistem operasi dan jaringan apapun, serta ditulis 

dalam bahasa pemrograman apapun. Pada penggunaan UML ini terdapat 3 macam 

diagram diantaranya Usecase diagram, Class diagram dan Activity diagram dan 

UML yang digunakan yaitu tipe diagram Usecase. 

  

  

 

 

                  

 

 

 

 

 

 

Gambar 3.4 Usecase Diagram User 

 

Keterangan : Pada usecase tersebut pengunjung dapat melihat halaman peta 

untuk mengetahui sebaran varietas ubi kayu di Provinsi Lampung, dan juga user 

dapat melakukan konsultasi kesesuaian lahan, juga melihat halaman informasi ubi 

kayu, dan data dari kabupaten/kota.  Pada gambar 3.3 adalah usecase diagram dari 

user site, yang dapat dilihat bahwa dari halaman index atau halaman depan dapat 

langsung menuju halaman yang diinginkan. 
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Menu Halaman User

Home

Konsultasi Lahan
Cek Kesesuaian

Lahan

Peta Kesesuaian

Lahan Lihat Peta

Infomasi Ubi Kayu

Kabupaten/Kota Lihat Informasi

Contact Informasi contact
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Aplikasi Admin

Data Berita

Administrator

Home

Data Admin

Admin

Login

Logout
Home Admin

 

 

 

 

 

 

 

 

 

Gambar 3.5 Usecase Diagram User Detail 

 

Keterangan : Pada usecase tersebut pengunjung dapat melihat detail setiap 

halaman.  Gambar 3.4 adalah usecase diagram dari user site. 

 

 

 

  

 

 

 

 

 

 

 

 

Gambar 3.6 Usecase Diagram Admin 

 

 

Keterangan : Pada usecase tersebut administrator dapat mengelola beberapa 

menu seperti update data admin, dan update data informasi kabupaten/kota.  Pada 

gambar 3.5 adalah usecase diagram dari halaman administrator site. 
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Gambar 3.7 Usecase Diagram Admin Detail 

 

Keterangan : Pada usecase tersebut administrator dapat menginput, hapus dan 

edit setiap halaman yang menjadi rolenya.  Pada gambar 3.6 adalah usecase 

diagram dari administrator site. 

 

3.5 Rancangan Struktur Database 

 

Rancangan struktur database sistem adalah sebagai berikut : 

 

a. Struktur Tabel Admin 

 Tabel ini digunakan untuk menyimpan data login admin. 

 Nama database  : amin 

 Nama tabel  : admin 

 Primary key  : id 

 Media penyimpanan : Harddisk 
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 Tabel 3.1 Rancangan Struktur Tabel Admin.  

Nama Field Tipe Data Ukuran Keterangan 

Id Varchar 30 Id Admin 

Nama Varchar 50 Username 

Password Varchar 50 Password Login 

 

b.   Struktur Tabel Analisa Hasil 

 Tabel ini digunakan untuk menyimpan data hasil konsultasi lahan 

 Nama database  : db_amin 

 Nama tabel  : Analisa_Hasil 

 Primary key  : id  

 Media penyimpanan : Harddisk 

 

Tabel 3.2 Rancangan Struktur Tabel Analisa Hasil 

 

Nama Field Tipe Data Ukuran Keterangan 

Id int 4 Id 

Nama Varchar 60 Nama Pasien 

Kelamin Enum(‘P’;’W’)  Jenis Kelamin 

Alamat Varchar 100 Alamat pasien 

Pekerjaan Varchar 60 Pekerjaan 

Kd_Varietas Char 4 Kd Varietas 

Noip Varchar 60 No Identitas Pasien 

Tanggal Datetime  Tanggal 

 

c.  Struktur Tabel Berita 

 Tabel ini digunakan untuk menyimpan data berita 

 Nama database  : amin 

 Nama tabel  : Berita 
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 Primary key  : id  

 Media penyimpanan : Harddisk 

 

Tabel 3.3 Rancangan Struktur Tabel Berita 

 

Nama Field Tipe Data Ukuran Keterangan 

Id Int 50 Id berita 

Judul Text  Judul berita 

Isi Text  Isi berita 

Tgl Datetime  Tgl 

Gambar Varchar 500 Gambar 

 

 

d.  Struktur Tabel Iklim 

 Tabel ini digunakan untuk menyimpan data Klimatologi Kab/Kota 

 Nama database  : amin 

 Nama tabel  : Iklim 

 Primary key  : Idsyarat  

 Media penyimpanan : Harddisk 

 

Tabel 3.4 Rancangan Struktur Tabel Iklim 

 

Nama Field Tipe Data Ukuran Keterangan 

Idsyarat Int 11 Idsyarat 

Kode_Kabupaten Int 11 Kode Kabupaten 

Tinggi_tempat Text  Tinggi Tempat 

Curah_hujan Text  Curah Hujan 

Suhu Text  Suhu 

Kelembapan Text  Kelembapan 
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e. Struktur Tabel Lampung 

 Tabel ini digunakan untuk menyimpan data Polygon Peta 

 Nama database  : amin 

 Nama tabel  : Lampung 

 Primary key  : ogr_fid  

 Media penyimpanan : Harddisk 

 

Tabel 3.5 Rancangan Struktur Tabel Lampung 

 

Nama Field Tipe Data Ukuran Keterangan 

Ogr_fid Int 11 Id Polygon 

Shape Geometry  File SHP Polygon 

Provinsi Varchar 50 Provinsi 

Kab_Kot Varchar 30 Kabupaten/Kota 

Ibukota Varchar 20 Ibu Kota 

Varietas Varchar 500 Varietas 

Kode_kabupaten int 11 Kode Kabupaten 

 

f. Struktur Tabel Luas Panen 

 Tabel ini digunakan untuk menyimpan data Polygon Peta 

 Nama database  : amin 

 Nama tabel  : Luas Panen 

 Primary key  : Idluaspanen  

 Media penyimpanan : Harddisk 
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Tabel 3.6 Rancangan Struktur Tabel Luas Panen 

 

Nama Field Tipe Data Ukuran Keterangan 

Idluaspanen Int 11 Id Luas Panen 

Kode_Kabupaten Int  11 Kode Kabupaten 

L_2010 Varchar 100 
Luas Panen Kab/Kot 

Tahun 2010 

L_2011 Varchar 
100 Luas Panen Kab/Kot 

Tahun 2011 

L_2012 Varchar 
100 Luas Panen Kab/Kot 

Tahun 2012 

L_2013 Varchar 
100 Luas Panen Kab/Kot 

Tahun 2013 

 

g. Struktur Tabel Pertanyaan 

 Tabel ini digunakan untuk menyimpan data Pertanyaan Konsultasi 

 Nama database  : amin 

 Nama tabel  : Pertanyaan 

 Primary key  : Kd_Soal  

 Media penyimpanan : Harddisk 

 

Tabel 3.7 Rancangan Struktur Tabel Pertanyaan 

 

Nama Field Tipe Data Ukuran Keterangan 

Kd_soal Char 4 Kode Soal 

Soal Varchar 100 Soal (Pertanyaan) 

 

h. Struktur Tabel Produksi 

 Tabel ini digunakan untuk menyimpan data Polygon Peta 

 Nama database  : amin 

 Nama tabel  : Produksi 
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 Primary key  : idproduksi  

 Media penyimpanan : Harddisk 

 

Tabel 3.8 Rancangan Struktur Tabel Produksi 

 

Nama Field Tipe Data Ukuran Keterangan 

idproduksi Int 11 Id Produksi 

Kode_Kabupaten Int 11 Kode Kabupaten 

P_2010 Varchar 100 
Hasil Produksi Kab/Kota 

Tahun 2010 

P_2011 Varchar 100 
Hasil Produksi Kab/Kota 

Tahun 2011 

P_2012 Varchar 100 
Hasil Produksi Kab/Kota 

Tahun 2012 

P_2013 Varchar 100 
Hasil Produksi Kab/Kota 

Tahun 2013 

 

i. Struktur Tabel Produktivitas 

 Tabel ini digunakan untuk menyimpan data Produktivitas Ubi Kayu Tiap  

  Kab/Kota 

 Nama database  : amin 

 Nama tabel  : Produktivitas 

 Primary key  : Idproduktivitas  

 Media penyimpanan : Harddisk 

 

Tabel 3.9 Rancangan Struktur Tabel Produktivitas 

 

Nama Field Tipe Data Ukuran Keterangan 

Idproduktivitas Int 11 Idproduktivitas 

Kode_Kabupaten Int 11 Kode Kabupaten 



53 
 

 
 

PR_2010 Varchar 100 
Produktivitas Ubi Kayu  

Kab/Kota Tahun 2010 

PR_2011 
Varchar 100 

Produktivitas Ubi Kayu  

Kab/Kota Tahun 2010 

PR_2012 
Varchar 100 

Produktivitas Ubi Kayu  

Kab/Kota Tahun 2010 

PR_2013 
Varchar 100 

Produktivitas Ubi Kayu  

Kab/Kota Tahun 2010 

 

j. Struktur Tabel Relasi 

 Tabel ini digunakan untuk menyimpan data Relasi Antara Tabel Pertanyaan  

  dan Tabel Varietas 

 Nama database  : amin 

 Nama tabel  : Relasi 

 Primary key  : Kdvarietas  

 Media penyimpanan : Harddisk 

 

Tabel 3.10 Rancangan Struktur Tabel Relasi 

 

Nama Field Tipe Data Ukuran Keterangan 

Kd_Varietas Char 4 Kode Varietas 

Soal Char 4 Kode Soal 

 

k. Struktur Tabel Titik 

 Tabel ini digunakan untuk menyimpan data Titik 

 Nama database  : amin 

 Nama tabel  : Titik 

 Primary key  : org_fid  

 Media penyimpanan : Harddisk 
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Tabel 3.11 Rancangan Struktur Tabel Titik 

 

Nama Field Tipe Data Ukuran Keterangan 

Org_fid Int 11 Id Titik 

Shape Geometry  File shp titik kordinat 

Kabupaten Varchar 100 Kabupaten 

Alamat Varchar 50 Alamat Titik Kordinat 

Kec Varchar 50 Kecamatan 

Hasil_Panen Varchar 100 Hasil Panen 

Luas_Panen Varchar 100 Luas Panen 

 

l. Struktur Tabel Tmp Analisa 

 Tabel ini digunakan untuk menyimpan data Temporari Analisa 

 Nama database  : amin 

 Nama tabel  : Tmp Analisa 

 Primary key  : noip  

 Media penyimpanan : Harddisk 

 

Tabel 3.12 Rancangan Struktur Tabel Tmp Analisa 

 

Nama Field Tipe Data Ukuran Keterangan 

Noip Varchar 60 No Identitas Pasien 

Kd_Varietas Char 4 Kode Varietas 

Kd_Soal Char 4 Kode Soal 

Status Enum(’Y’;’N’)  Status Pertanyaan 

 

m. Struktur Tabel Tmp Pasien 

 Tabel ini digunakan untuk menyimpan data Temporari Pasien 
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 Nama database  : amin 

 Nama tabel  : Tmp Pasien 

 Primary key  : Id   

 Media penyimpanan : Harddisk 

 

Tabel 3.13 Rancangan Struktur Tabel Tmp Pasien 

 

Nama Field Tipe Data Ukuran Keterangan 

Id Int 4 Id Pasien 

Nama Varchar 60 Nama Pasien 

Kelamin Enum(’P’;’W’)  Jenis Kelamin 

Alamat Varchar 100 Alamat Pasien 

Pekerjaan Varchar 60 Pekerjaan Pasien 

Noip Varchar 60 No Identitas Pasien 

Tanggal Datetime   

 

 

n. Struktur Tabel Tmp Pertanyaan 

 Tabel ini digunakan untuk menyimpan data Temporary Pertanyaan 

 Nama database  : amin 

 Nama tabel  : Tmp Pertanyaan 

 Primary key  : Kd_soal  

 Media penyimpanan : Harddisk 

 

Tabel 3.14 Rancangan Struktur Tabel Tmp Pertanyaan 

 

Nama Field Tipe Data Ukuran Keterangan 

Kd_Soal Char 4 Kode Soal 

Noip Varchar 100 No Identitas Pasien 
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o. Struktur Tabel Tmp Varietas 

 Tabel ini digunakan untuk menyimpan data Temporari Varietas 

 Nama database  : amin 

 Nama tabel  : Tmp Varietas 

 Primary key  : Kd_Varietas   

 Media penyimpanan : Harddisk 

Tabel 3.15 Rancangan Struktur Tabel Tmp Varietas 

 

Nama Field Tipe Data Ukuran Keterangan 

Kd_Varietas Char 4 Kode Varietas 

Noip Varchar 100 No Identitas Pasien 

 

 

p. Struktur Tabel Varietas 

 Tabel ini digunakan untuk menyimpan data Varietas Ubi Kayu 

 Nama database  : amin 

 Nama tabel  : Varietas 

 Primary key  : Kd_Varietas  

 Media penyimpanan : Harddisk 

 

Tabel 3.16 Rancangan Struktur Tabel Varietas 

 

Nama Field Tipe Data Ukuran Keterangan 

Kd_Varietas Char 4 Kode Varietas 

Nama_Varietas Varchar 100 Nama Varietas 

Umur Varchar 100 Masa Panen 

Kadar_Pati Varchar 100 Kadar Pati Varietas 

Produksi Varchar 100 Hasil Panen 

Sistem_Tanam Varchar 100 Sistem Tanam 

Keterangan Text  Keterangan 
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3.6 Perangkat Lunak 

 

Pada tahap ini akan dijelaskan mengenai spesifikasi perangkat lunak yang 

digunakan dalam perancangan Sistem Informasi Geografis Kesesuaian Lahan 

Tanaman ubi kayu Pada Provinsi Lampung, yaitu: 

1. Sistem Operasi Windows XP 

2. ArcView 

3. XAMPP 

4. Macromedia Dreamweaver 8 

 

 

3.7 Perangkat Keras 
 

Pada tahap ini akan dijelaskan mengenai spesifikasi minimum perangkat keras 

yang digunakan dalam Sistem Informasi Geografis Kesesuaian Lahan Tanaman 

ubi kayu Pada Provinsi Lampung, yaitu: 

1. Processor Core 2 1.73GHz 

2. Ram 512 MB 

3. Monitor 

4. Mouse 

5. Keyboard 

6. Printer Canon IP 2700 

 

 

3.8 Desain Interface 

 

Antarmuka atau yang lebih dikenal sebagai user interface adalah sebuah media 

yang menghubungkan manusia dengan komputer agar dapat saling berinteraksi. 

Berikut ini adalah rancangan user interface. 

 

A. Rancangan Menu Utama Website 

 Dibawah ini merupakan rancangan tampilan menu utama pada website ini 

 dapat dilihat pada Gambar 3.11 
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Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

BERITA

footer
 

      Gambar 3.8 Rancangan Menu Utama website 

 

B. Rancangan Menu Utama User 

Dibawah ini merupakan tampilan menu utama untuk para pengunjung website 

tampilan menu utama pada website ini dapat dilihat pada Gambar 3.12 

 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

BERITA

footer
 

   Gambar 3.9 Rancangan Menu Utama User 
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C. Rancangan Halaman Peta Kesesuaian Lahan 

Rancangan berikut merupakan halaman untuk peta kesesuaian lahan ubi kayu, 

rancangan halamannya dapat dilihat pada Gambar 3.13 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

PETA KESESUAIAN LAHAN

footer
 

   Gambar 3.10 Rancangan Halaman Peta Kesesuaian Lahan Peta 

 

D. Rancangan Halaman Informasi Ubi Kayu Kabupaten/Kota 

Rancangan berikut merupakan halaman untuk informasi ubi kayu 

Kabupaten/Kota, rancangan halamannya dapat dilihat pada Gambar 3.14 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

INFORMASI UBI KAYU 

KABUPATEN/KOTA

footer

 Gambar 3.11 Rancangan Halaman Informasi Ubi Kayu Kabupaten/Kota 
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E. Rancangan Halaman Konsultasi Lahan 

Dibawah ini merupakan rancangan halaman konsultasi lahan ubi kayu untuk 

para pengunjung.  

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

KONSULTASI LAHAN

footer

   Gambar 3.12 Rancangan Halaman Konsultasi Lahan 

 

F. Rancangan Halaman Contact 

Rancangan Halaman contact dibuat untuk membantu pengunjung dalam 

mengetahui informasi dari Dinas - dinas terkait di Provinsi Lampung, 

rancangan halaman dapat dilihat pada Gambar 3.16 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

CONTACT

footer
 

Gambar 3.13 Rancangan Halaman Contact 
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G. Rancangan Halaman Home Admin 

Rancangan halaman dapat dilihat pada Gambar 3.17 

Header

| HOME | | DATA TITIK | | DATA BERITA |DATA ADMIN|

HALAMAN ADMINISTRATOR

FOOTER
 

  Gambar 3.14 Rancangan Halaman Home Admin 

 

H. Rancangan Halaman Data Titik 

Berikut adalah rancangan halaman data titik dapat dilihat pada gambar 

dibawah ini. 

Header

| HOME | | DATA TITIK | | DATA BERITA |DATA ADMIN|

Olah Data Titik

INPUT + EDIT + DELETE

FOOTER
 

 Gambar 3.15 Rancangan Halaman Data Titik 
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I. Rancangan Halaman Data Berita 

Rancangan Halaman Data Berita dibuat untuk mengolah data berita 

Header

| HOME | | DATA TITIK | | DATA BERITA |DATA ADMIN|

DATA BERITA

INPUT + EDIT + DELETE

FOOTER
 

 Gambar 3.16 Rancangan Halaman Data Berita 

 

J. Rancangan Halaman  Data Admin 

Rancangan Halaman admini dibuat untuk mengolah data login ke halaman 

administrator Halaman dapat dilihat pada Gambar 3.20 

Header

| HOME | | DATA TITIK | | DATA BERITA |DATA ADMIN|

OLAH ADMIN

INPUT + EDIT + DELETE

FOOTER

 Gambar 3.17 Rancangan Halaman Admin 
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K. Rancangan Halaman Login 

Rancangan Halaman Login dibuat untuk login administrator. Halaman dapat 

dilihat pada Gambar 3.21 

 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

TABEL LOGIN

FOOTER

 Gambar 3.18 Rancangan Halaman Login Administrator 

 

L. Rancangan Halaman Login gagal 

Rancangan Halaman Login gagal dibuat untuk memblok user yang ingin 

mencoba login sebagai administrator. Halaman dapat dilihat pada Gambar 

3.22 

Header

| HOME | | PETA KESESUAIAN LAHAN | |INFORMASI UBI KAYU KABUPATEN/KOTA| |KONSULTASI LAHAN | | CONTACT|

LOGIN GAGAL

TABEL LOGIN

FOOTER

 Gambar 3.19 Rancangan Halaman Login Gagal 


